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В целях природы обуздания,
Чтобы рассеять незнания тьму,
Берем картину мироздания
И тупо смотрим, что к чему.…

А. и Б. Стругацкие. 
«Понедельник начинается в субботу»

ПРЕДИСЛОВИЕ
Одним из основных инструментов познания мира является обработка данных, 
получаемых человеком из различных источников. Суть современного статисти-
ческого анализа состоит в интерактивном процессе, состоящем из исследования, 
визуализации и интерпретации потоков поступаемой информации. 

История последних 50 лет – это и история развития технологии анализа дан-
ных. Один из авторов этой книги с умилением вспоминает конец 60-х годов и свою 
первую программу расчета парной корреляции, которая набиралась металличе-
скими штыречками на «операционном поле» из 150 ячеек персональной ЭВМ 
«Промiнь-2» весом более 200 кг. В наше время высокопроизводительные компью-
теры и доступное программное обеспечение позволяют реализовать полный цикл 
информационно-технологического процесса, состоящего, в общем случае, из сле-
дующих шагов: 

  доступ к обрабатываемым данным (их загрузка из разных источников 
и комплектация совокупности взаимосвязанных исходных таблиц); 

  редактирование загруженных показателей (замена или удаление пропу-
щенных значений, преобразование признаков в более удобный вид); 

  аннотирование данных (чтобы помнить, что представляет собой каждый их 
фрагмент);

  получение общих сведений о структуре данных (вычисление описательных 
статистик); 

  графическое представление данных и результатов вычислений в понятной 
информативной форме (одна картинка на самом деле иногда стоит тысячи 
слов); 

  моделирование данных (математическое описание зависимостей и тестиро-
вание статистических гипотез); 

  оформление результатов (подготовка таблиц и диаграмм приемлемого пуб-
ликационного качества).

В условиях, когда в распоряжении пользователя имеются десятки пакетов при-
кладных программ, актуальна проблема выбора (иногда трагичная, если вспом-
нить «буриданова осла»): какое программное обеспечение анализа данных следу-
ет предпочесть для своей практической работы? Здесь обычно принимаются во 
внимание специфика решаемой задачи, эффективность настройки алгоритмов 
обработки, издержки на покупку программ, а также вкусы и личные предпочте-
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ния исследователя. При этом, например, шаблонная Statistica с ее механическим 
комплексом кнопок меню далеко не всегда может удовлетворить творческого иссле-
дователя, предпочитающего самостоятельно контролировать ход вычислительного 
процесса. Комбинировать различные типы анализа, иметь доступ к промежуточным 
результатам, управлять стилем отображения данных, добавлять собственные рас-
ширения программных модулей и оформлять итоговые отчеты в необходимом виде 
позволяют коммерческие вычислительные системы, включающие высокоуровне-
вые средства командного языка, такие как Matlab, SPSS и др. Прекрасной альтер-
нативой им является бесплатная программная среда R, являющаяся современной 
и постоянно развивающейся статистической платформой общего назначения.

Сегодня R является безусловным лидером среди свободно распространяемых 
систем статистического анализа, о чем говорит, например, тот факт, что в 2010 го-
ду система R стала победителем ежегодного конкурса открытых программных 
продуктов Bossie Awards в нескольких номинациях. Ведущие университеты мира, 
аналитики крупнейших компаний и исследовательских центров регулярно ис-
пользуют R при проведении научно-технических расчетов и создании крупных 
информационных проектов. Широкое преподавание статистики на базе пакетов 
этой среды и всемерная поддержка научным сообществом обусловили то, что при-
ведение скриптов R постепенно становится общепризнанным «стандартом» как 
в журнальных публикациях, так и при неформальном общении ученых всего мира.

Главным препятствием для русскоязычных пользователей при освоении R, 
безуслов но, является то, что почти вся документация по этой среде существует на 
английском языке. Лишь с 2008 года усилиями А. В. Шипунова, Е. М. Балдина, 
С. В. Петрова, И. С. Зарядова, А. Г. Буховца, П. А. Волковой и других энтузиастов 
появились методические пособия и книги на русском языке (ссылки на них мож-
но найти в списке литературы в конце этой книги; там же представлены и ссылки 
на образовательные ресурсы, авторами которых делается посильный вклад в про-
движение R среди русскоязычных пользователей). Настоящая книга дополняет 
эту небольшую (пока) коллекцию работ по R на русском языке, обобщая совокуп-
ность методических сообщений, опубликованных одним из авторов с 2011 года 
в блоге «R: Анализ и визуализация данных» (http://r-analytics.blogspot.com). Нам 
показалась целесообразной идея представить для удобства читателей весь этот не-
сколько разобщенный материал в концентрированной форме, а также расширить 
некоторые разделы для полноты изложения. 

В первых трех главах содержатся подробные указания по работе с интерактив-
ными компонентами R, детальное описание языка и базовых графических воз-
можностей среды. Эта часть книги вполне доступна новичкам в области програм-
мирования, хотя читатель, уже знакомый с языком R, может найти там интересные 
фрагменты кода или использовать приведенные описания графических парамет-
ров как справочное пособие.

В последующих главах (4–8) приведено описание распространенных процедур 
обработки данных и построения статистических моделей, которое иллюстрирова-
но несколькими десятками примеров. Все эти главы включают краткие описания 
соответствующих алгоритмов анализа, основные полученные в примерах резуль-
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таты и их возможную интерпретацию. Мы старались, по возможности, обойтись 
без злоупотребления «ритуальными» словооборотами, характерными для много-
численных руководств по статистике, цитирования общеизвестных теорем и при-
ведения многоэтажных расчетных формул. Акцент делался в первую очередь на 
практическое применение – на то, чтобы читатель, руководствуясь прочитанным, 
мог проанализировать свои данные и изложить результаты коллегам.

Материал выстроен по мере усложнения. Так, главы 4 и 5 ориентированы на 
читателя, интересующегося статистикой лишь в объеме начального университет-
ского курса. В главах 6 и 7 в рамках единой теории общих линейных моделей пред-
ставлены дисперсионный и регрессионный анализы и приведены различные алго-
ритмы исследования и структурной идентификации моделей. Глава 8 посвящена 
некоторым современным методам построения и анализа обобщенных линейных 
и иных типов моделей.

Поскольку неизменный интерес у исследователей вызывают пространствен-
ный анализ и визуализация данных на географических картах и схемах, в главе 9 
приведены некоторые примеры соответствующих приемов.

Отдельно стоит упомянуть обозначения, принятые в книге. Все команды языка 
R выделены моноширинным шрифтом. При этом имена функций дополнительно выделе-
ны полужирным шрифтом, как в этом примере: mean(с(1, 2, 3)). При упоминании 
каких-либо функций в тексте мы всегда добавляем к их именам круглые кавыч-
ки, что позволяет отличать функции от других объектов R (например, summary()). 
Результаты вычислений, полученные при использовании той или иной функции, 
выделены шрифтом синего цвета. Наконец, комментарии к коду представлены на-
клонным шрифтом серого цвета и начинаются со знака #:

# Расчет среднего значения:
mean(c(1, 2, 3))
[1] 2

Мы адресуем эту книгу студентам, аспирантам, а также молодым и состоявшим-
ся ученым, желающим освоить анализ и визуализацию данных с использованием 
среды R. Мы надеемся, что по окончании чтения этого руководства вы получите 
некоторое представление о том, как работает R, где можно получить дальнейшую 
информацию, а также как справиться с широким спектром задач анализа данных.

Файлы со скриптами кода R по всем главам книги и таблицы исходных дан-
ных, необходимые для выполнения примеров, свободно доступны для скачивания 
с GitHub-репозитория https://github.com/ranalytics/r-tutorials, а также с сайта 
Института экологии Волжского бассейна РАН по ссылке http://www.ievbras.ru/
ecostat/Kiril/R/Scripts.zip.

Мы будем благодарны Вам, Читатель, за любые замечания и пожелания ка-
сательно этой работы, которые Вы можете направлять по электронной почте 
rtutorialsbook@gmail.com.

Сергей Мастицкий, Лондон
Владимир Шитиков, Тольятти

май 2015 года



Глава 1
Основные компоненты 

статистической среды R

1.1. История возникновения и основные принципы 
организации среды R
Система статистического анализа и визуализации данных R состоит из следую-
щих основных частей:

  языка программирования высокого уровня R, позволяющего одной строкой 
реализовать различные операции с объектами, векторами, матрицами, спис-
ками и т. д.;

  большого набора функций обработки данных, собранных в отдельные так 
называемые «пакеты»;

  развитой системой поддержки, включающей обновление компонентов сре-
ды, интерактивную помощь и различные образовательные ресурсы, предна-
значенные как для начального изучения R, так и для последующих консуль-
таций по возникающим затруднениям.

Начало пути относится к 1993 г., когда двое молодых новозеландских ученых 
Росс Ихака (Ross Ihaka) и Роберт Джентльмен (Robert Gentleman) анонсировали 
свою новую разработку, которую назвали R. Они взяли за основу язык програм-
мирования развитой коммерческой системы статистической обработки данных 
S-PLUS и создали его бесплатную свободную реализацию, отличающуюся от свое-
го прародителя легко расширяемой модульной архитектурой. В скором времени 
возникла распределенная система хранения и распространения пакетов к R, из-
вестная под аббревиатурой «CRAN» (Comprehensive R Archive Network – http://
cran.r-project.org), основная идея организации которой – постоянное расширение, 
коллективное тестирование и оперативное распространение прикладных средств 
обработки данных.

Оказалось, что такой продукт непрерывных и хорошо скоординированных уси-
лий мощного «коллективного разума» тысяч бескорыстных разработчиков-ин-
теллектуалов оказался значительно эффективнее коммерческих статистических 
программ, стоимость лицензии на которые может составлять несколько тысяч 
долларов. Поскольку R является любимым языком профессиональных статисти-
ков, все последние достижения статистической науки очень быстро становятся 
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доступными для пользователей R во всем мире в виде дополнительных пакетов. 
Ни одна коммерческая система статистического анализа так быстро сегодня не 
развивается. У R есть многочисленная армия пользователей, которые сообщают 
авторам дополнительных пакетов и самой системы R об обнаруженных ошибках, 
которые оперативно исправляются.

Язык вычислений R, хотя и требует определенных усилий для своего освое-
ния, недюжинных поисковых навыков и энциклопедической памяти, позволяет 
оперативно выполнить расчеты, по своему разнообразию практически «столь же 
неисчерпаемые, как атом». По состоянию на конец февраля 2015 г., энтузиастами 
со всего мира было создано 7336 дополнительных библиотек для R, включающих 
149 688 функций (см. http://www.rdocumentation.org), которые существенно рас-
ширяют базовые возможности системы. Очень сложно представить какой-либо 
класс статистических методов, который еще не реализован сегодня в виде пакетов 
R, включая, разумеется, весь «джентльменский набор»: линейные и обобщенные 
линейные модели, нелинейные регрессионные модели, планирование экспери-
мента, анализ временных рядов, классические параметрические и непараметриче-
ские тесты, байесовская статистика, кластерный анализ и методы сглаживания. 
При помощи мощных средств визуализации результаты анализа можно обобщать 
в виде всевозможных графиков и диаграмм. Кроме традиционной статистики, 
разработанный функционал включает большой набор алгоритмов численной ма-
тематики, методов оптимизации, решения дифференциальных уравнений, рас-
познавания образов и др. Свои специфические методы обработки данных могут 
обнаружить в составе пакетов R генетики и социологи, лингвисты и психологи, 
химики и медики, специалисты по ГИС- и веб-технологиям. 

«Фирменная» документация по R весьма объемна и далеко не всегда толково 
написана (по странной традиции англоязычной литературы, слишком много слов 
расходуется на описание тривиальных истин, тогда как важные моменты пробе-
гаются скороговоркой). Однако в дополнение к этому ведущими мировыми из-
дательствами (Springer, Cambridge University Press и Chapman & Hall/CRC) или 
просто отдельными коллективами энтузиастов выпущено огромное число книг, 
описывающих различные аспекты анализа данных в R (см., например, список 
литературы на сайте «Энциклопедия психодиагностики», http://psylab.info/
R:Литература). Кроме того, существует несколько активно действующих между-
народных и российских форумов пользователей R, где любой может попросить 
о помощи в возникшей проблеме. В списке литературы мы приводим пару сотен 
книг и интернет-ссылок, на которые советуем обратить особое внимание в ходе 
изучения R.

Непосредственное обучение практической работе в R состоит из а) освоения 
конструкций языка R и знакомства с особенностями вызова функций, выполняю-
щих анализ данных, и б) приобретения навыков работы с  программами,  реализую-
щими специфические методы анализа и визуализации данных.

Вопрос выбора средств пользовательского интерфейса R неоднозначен 
и сильно зависит от вкусов пользователей. Единого мнения нет даже у авто-



ритетных специалистов. Одни считают, что нет ничего лучше стандартного 
консольного интерфейса R. Другие полагают, что для удобной работы стоит 
инсталлировать какую-либо из имеющихся интегрированных сред разработки 
(IDE) с богатым набором кнопочных меню. Например, отличным вариантом 
является бесплатная интегрированная среда разработки RStudio (http://www.
rstudio.com). Ниже мы остановимся на описании консольного варианта и на ра-
боте с R Commander, но дальнейшим исканиям читателя может помочь обзор 
различных версий IDE, представленный в приложении к книге А. Шипунова 
с соавторами (2014). 

Один из R-экспертов, Джозеф Рикерт, считает, что процесс изучения R мож-
но разделить на следующие этапы (подробнее см. его статью на сайте http://bit.
ly/1FlOx2E): 

1. Знакомство с общими принципами культуры R-сообщества и программной 
среды, в которой разрабатывался и функционирует язык R. Посещение ос-
новных и вспомогательных ресурсов и освоение хорошего вводного учеб-
ника. Инсталляция R на компьютере пользователя и выполнение первых 
тестовых скриптов.

2. Считывание данных из стандартных файлов операционной системы и уве-
ренное использование R-функций для выполнения ограниченного набора 
привычных  пользователю процедур статистического анализа.

3. Использование базовых структур языка R для написания простых про-
грамм. Написание собственных функций. Ознакомление со структурами 
данных, с которыми может работать R, и более сложными возможностями 
языка. Работа с базами данных, веб-страницами и внешними источниками 
данных.

4. Написание сложных программ на языке R. Самостоятельная разработ-
ка и глубокое понимание структуры объектов так называемых S3- и S4-
классов.

5. Разработка профессиональных программ на языке R. Самостоятельное соз-
дание дополнительных модулей для R.

Большинство рядовых пользователей R останавливаются на стадии 3, так как 
полученных к этому времени знаний им вполне достаточно для выполнения ста-
тистических задач по профилю их основной профессиональной деятельности. 
Примерно в этом объеме мы и приводим описание языка R в рамках настоящего 
руководства.

Установить и настроить базовую комплектацию статистической среды R весь-
ма просто. На момент написания этой книги актуальной была версия R 3.1.2 для 
Windows (доступны также дистрибутивы для всех других распространенных опе-
рационных систем). Скачать дистрибутив системы вместе с базовым набором из 
29 пакетов можно совершенно бесплатно с основного сайта проекта http://cran.r-
project.org или его русского «зеркала» http://cran.gis-lab.info. Процесс инсталля-
ции системы из скачанного дистрибутива затруднений не вызывает и не требует 
никаких особых комментариев. 

История возникновения и принципы организации среды R  15



16  Основные компоненты статистической среды R

Для удобства хранения скриптов, исходных данных и результатов расчетов 
стоит выделить на пользовательском компьютере специальный рабочий каталог. 
Весьма нежелательно использовать в названии рабочего каталога символы кирил-
лицы. 

Путь к рабочему каталогу и некоторые другие опции настроек целесообразно 
разместить, изменив в любом текстовом редакторе системный файл C:\Program 
Files\R\R-3.1.2\etc\Rprofile.site (на вашем компьютере он может иметь иной 
адрес). В представленном ниже примере модифицированные строки отмечены 
синим цветом. Помимо указания рабочего каталога, эти строки определяют ссыл-
ку на российский источник загрузки пакетов R и автоматический запуск R Com-
mander.

Листинг файла Rprofile.site

# Все, что следует за символом комментария "#", средой игнорируется
# options(papersize="a4")
# options(editor="notepad")
# options(pager="internal")

# установить тип отображения справочной информации
# options(help_type="text")
  options(help_type="html")

# установить место расположения локальной библиотеки
# .Library.site <- fi le.path(chartr("\\", "/", R.home()), "site-library")

# При загрузке среды запустить меню R Commander
# Поставить знаки #, если запуск Rcmdr не нужен
 local({
 old <- getOption("defaultPackages")
 options(defaultPackages = c(old, "Rcmdr"))
 })

# Определить зеркало CRAN
 local({r <- getOption("repos")
       r["CRAN"] <- "http://cran.gis-lab"
       options(repos = r)})

# Определить путь к рабочему каталогу (любой иной на вашем компьютере)
setwd("D:/R/Process/Resampling")

Что касается «хорошего вводного учебника», то любые наши рекомендации 
неизбежно будут носить субъективный оттенок. Тем не менее следует упомянуть 
официальное введение в R (Venables & Smith, 2014) и книгу Kabacoff (2011), отчас-
ти еще и потому, что имеется их русский перевод. Отметим также традиционное 
«наставление для чайников» Meys & Vries (2012) и руководства Dalgaard (2008) 
и Lam (2010). Из русскоязычных вводных книг наиболее полными являются ра-
боты И. Зарядова (2010а, б) и А. Шипунова с соавторами (2014). 



1.2. Работа с командной консолью
Статистическая среда R выполняет любой набор осмысленных инструкций язы-
ка R, содержащихся в файле скрипта или представленных последовательностью 
команд , задаваемых с консоли. Работа с консолью может показаться трудной для 
современных пользователей, привыкших к кнопочным меню, поскольку надо за-
поминать синтаксис отдельных команд. Однако после приобретения уже неко-
торых первичных навыков окажется, что многие процедуры обработки данных 
можно выполнять быстрее и с меньшим трудом, чем, предположим, в той же про-
грамме Statistica. 

Консоль R представляет собой диалоговое окно, в котором пользователь вво-
дит команды и результаты их выполнения. Это окно возникает сразу при запуске 
среды (например, после клика мышью на ярлыке R на рабочем столе). Кроме того, 
стандартный графический пользовательский интерфейс R (RGui) включает окно 
редактирования скриптов и всплывающие окна с графической информацией (ри-
сунками, диаграммами и прочим).

В командном режиме R может работать, например, как обычный калькулятор 
(рис. 1). Справа от символа приглашения («prompt») > пользователь может ввести 
произвольное арифметическое выражение, нажать клавишу Enter и тут же полу-
чить результат. Например, во второй команде на рис. 1 мы использовали функции 
факториала и синуса, а также встроенное число . Результаты, полученные в текс-
товой форме, можно выделить мышью и скопировать через буфер обмена в любой 
текстовый файл (например, документ Word).

Рисунок 1

Работа с командной консолью  17
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При работе с использованием RGui мы рекомендуем во всех случаях создавать 
скрипт (то есть файл с последовательностью команд языка R, выполняющей опре-
деленные действия). Как правило, это обычный текстовый файл с любым именем 
и, желательно, расширением .r, который можно создавать и редактировать обыч-
ным редактором типа «Блокнот». Если этот файл существует, его лучше всего по-
местить в рабочий каталог, и тогда после запуска R и выбора пункта меню Файл 
> Открыть скрипт (File > Open script) содержимое этого файла появится в окне 
Редактор R (R Editor). Выполнить последовательность команд скрипта можно 
из пункта меню Правка > Запустить все (Edit > Run all). Можно также выде-
лить мышью осмысленный фрагмент из любого места подготовленного скрипта 
(от имени одной переменной до всего содержимого) и осуществить запуск этого 
блока на выполнение. Это можно сделать четырьмя возможными способами: из 
основного и контекстного меню, комбинацией клавиш Ctrl+R или кнопкой  на 
панели инструментов. 

Рисунок 2 описывает следующие действия:
  из бесплатного интернет-источника Global Administrative Areas (http://

gadm.org/) был скачан R-объект gadm с данными по территориальному деле-
нию Республики Беларусь;

  переменная NAME_1, cодержащая названия областных центров, преобразова-
на в объект класса «фактор»;

  с использованием функции spplot() из пакета sp в графическое окно про-
граммы выведена административная карта, которую можно средствами 

Рисунок 2



меню скопировать в буфер обмена или сохранить как стандартный мета- 
или растровый графический файл.

Подробнее смысл отдельных команд мы рассмотрим в последующих разделах, 
а здесь обратим внимание на то, что, выделив в скрипте и запустив на выполне-
ние комбинацию символов Regions@data, мы получим в окне консоли весь набор 
данных data по объекту gadm, а команда, составленная из выделенных символов 
Regions@data$NAME_1, даст нам список наименований административных центров. 

Таким образом, Редактор R позволяет легко выполнить навигацию по скрипту, 
редактирование и выполнение любой комбинации команд, поиск и замену опреде-
ленных частей кода. Упомянутая выше интегрированная среда разработки RStu-
dio позволяет дополнительно выполнять подсветку синтаксиса кода, его автома-
тическое завершение, «упаковку» последовательностей команд в функции для их 
последующего использования, работу с документами Sweave или TeX и другие 
операции, которые будут полезны продвинутому пользователю. 

R обладает обширными встроенными справочными материалами, кото-
рые можно получить непосредственно в RGui. Если подать с консоли команду 
help.start(), то в вашем интернет-браузере откроется страница, предоставляющая 
доступ ко всем внутренним справочным ресурсам: основным руководствам, автор-
ским материа лам, ответам на распространенные вопросы, истории внесенных в R 
изменений и т. д. (рис. 3).

Рисунок 3

Справку по отдельным функциям можно получить с использованием следую-
щих команд:

  help("foo") или ?foo  –  справка по функции foo (кавычки необязательны);
  help.search("foo") или ??foo – поиск всех справочных файлов, содержащих 
foo;
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  example("foo")  – примеры использования функции foo;
  RSiteSearch("foo")  – поиск ссылок в онлайн-руководствах и архивах рас-

сылок;
  apropos("foo", mode = "function")  – список всех функций,   в названии кото-

рых встречается foo;
  vignette("foo")  – список руководств по теме foo.

1.3. Работа с меню R Commander
Удобным средством освоения вычислений в R для начинающего пользовате-
ля является R Commander – платформонезависимый графический интерфейс 
c кнопочным меню, реализованный в пакете Rcmdr. Он позволяет осуществить 
большой комплект процедур статистического анализа, не прибегая к предвари-
тельному заучиванию функций на командном языке, однако невольно способ-
ствует этому, поскольку отображает все выполняемые инструкции в консоли 
программы.

Установить Rcmdr, как и любые другие расширения, можно из меню Пакеты > 
Установить пакет (Packages > Install package(s)), но лучше выполнив коман ду:

install.packages("Rcmdr", dependencies = TRUE),

где включение опции dependencies вызовет гарантированную установку полного 
комплекта остальных пакетов, которые могут потребоваться при обработке дан-
ных через меню Rcmdr. Обратите внимание: выполнение приведенной команды 
предполагает, что ваш компьютер подключен к Интернету.

Запуск R Commander происходит при загрузке пакета Rcmdr через меню Пакеты 
> Включить пакет (Packages > Load package) или командой library(Rcmdr).

Если по какой-то причине было принято решение анализировать данные ис-
ключительно с помощью R Commander, то для автоматической загрузки этой гра-
фической оболочки при запуске R необходимо отредактировать файл Rprofi le.site 
(см. раздел 1.1).

Работу в R Commander рассмотрим на примере корреляционного анализа дан-
ных по уровню инвазированности двустворчатого моллюска Dreissena polymor-
pha (http://bit.ly/1C0WvOW) инфузорией Conchophthirus acuminatus в трех озе-
рах Беларуси (Mastitsky, 2013, http://bit.ly/1wsDKm4). В таблице с исходными 
данными, которую скачаем с сайта figshare (http://bit.ly/1wMGDOQ), нас будут 
интересовать две переменные: длина раковины моллюска (ZMlength, мм) и число 
обнаруженных в моллюске инфузорий (CAnumber). Подробно этот пример будет 
рассмотрен в главах 4 и 5, поэтому здесь мы не будем детально останавливаться на 
смысле анализа, а сосредоточимся на технике работы с Rcmdr.

Первый этап – загрузка нового набора данных, и мы выбираем из меню Данные 
> Импорт данных… из URL (Data > Import data … from URL) (рис. 4).

Далее определяем во всплывающих окнах режим загрузки данных и адрес ссыл-
ки в Интернете. Нетрудно заметить, что те же данные мы могли легко загрузить 



из локального текстового файла, книги Excel или таблицы базы данных. Чтобы 
убедиться в том, что наши данные загружены верно (и при необходимости их от-
редактировать), нажимаем кнопку Посмотреть данные (View data set) (рис. 5).

Рисунок 4

Фрагмент загруженной таблицыОкно спецификации данных

Рисунок 5

На втором этапе в меню Статистики > Итоги (Statistics > Summaries) выбираем 
Корреляционный тест (Correlation test) (рис. 6).

Выделяем пару необходимых переменных, жмем OK и в окне вывода получаем 
коэффициент корреляции Пирсона (R = 0.467), уровень достигнутой статистиче-
ской значимости (p-value < 2.2e-16) и 95%-ные доверительные пределы (рис. 7). 
Полученные результаты легко скопировать из окна вывода через буфер обмена.

Теперь получим графическое изображение корреляционной зависимости. 
В ме ню Графики (Graphs) выберем Точечный график (Scatterplot) зависимости 
CAnumber от ZMlength и снабдим ее краевыми диаграммами размахов, линией линей-
ного тренда по методу наименьших квадратов (зеленым цветом) и сглаживающей 
линией по методу локальной регрессии (красным цветом), представленной с до-
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